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� �
��3�# 4�3� ��I ��!�

        ��
� 	��'# �� �('= 
� �.H� �3!% �C��[ x3^	        �'^ Z#
" �	

 �C��[ L� �3�# �� ���� ��!�  ����	 �R�� �
�   98
�  ��
         �3�	 �
Y�� �� �%
� K
3H56 K
&

N# �
Y�� ) �,'[ Z3�)�0   .  �HC�# 7�� �	 )�HC�# ��
� ���!� (    �'^ �C��[ �� �
3�  �
�

�5� �!3+� �!%)�� �!N!# 9
� ) 9`
^�"
�    .

min
2115 2110L 62.5m

0.08
−

= =

min
2115 2110 1L ( ) 100 1.25cm

0.08 5000
−

= × × =



�p

   * �'^ �C��[ �R�� �
�   :   �'^ �HC�# 7�� �	     �# 9
� �� �3�# �R�� �
�93!%   .              	��	 	'8() -)� )	 �
8% 78�� ����        :
s,� (S �	

 �'^ (�3O='H% �'^
s,� (�	

 �'^:
 * �'�
	Line/Curves> Curve Between Two lines �3!% ��(� �� .
 *�# ��
| �
5# 73,)� S
;��� �'�
	 �
#�� W� �		'" .�3!% L3H% >)� �
5# �)�.
 *�# ��
| �
5# 73#)	 S
;��� �'�
	 {�
	'" .�3!% S
;��� �� �)	 �
5#.
   *   �# $
�0 �C��[ �'�%
� �'� �
#�� W� �		'"   .$30 K�':� 4
� ��
% ) 4
� �
A" �'�%
�  �'�%
� 7�� t��Enter

�3�	 �
/� ��.
FACTOR [Length/Tangent/External/Degree/Chord/Mid/MDist/<Radius>]:

 *�# ��
�'� �
A" ���R# �
#�� W� �		'".

Radius:

 *�3!% 	��) �� �C��[ �
A" .�3!% �	
��
� ��� >'#�� �� Z^��C �
A" S
;��� ����.

)jgl(
 *9���	 >'#�� 7�� �	:

V = �'^ �C��[ 46�
)46

 �� ��#'H3%(

e =��)�	)�'^ �	 �]�6 @3" �w%��C 
� ��!H����( ����� 	����
�
� �	  e%�3B'= �

� ��   �B.C.E.O.M�   % �

� �� )

�3B'= '�"� � ) S� W���" �

������'�)   (f   %  �3
	�
 x[
!# ����e   %  	�
 >��A# x[
!# ����lv   %       x8[
8!8# ���8�

 ) ��� >��A#ln %�3�#�� x[
!# ���� . >'#�� �	e����F<� ��B 
� ��  . ��� ?w#e=8% 	�6 >'#�� �	 �"
�v/ve ���^ �� 

�3�	.

f =>)�( �� �&�
( �
._B� @��]jgl

Rmin =��# @�C�� �'^ �C��[ Z^��C �
A"
  * >'#�� ��jgl�# �&

N# �C��[ �
A" Z^��C  $3� ����R# �3!% �A
 �% 	'" >'#�� �� ZB
C ���R# ��jgl  �
83��� 

�3!% .�
='% �3�# �,) ��" ��/3� �'^ >'[  �"
� ������ �'^ �
A" �*�� �3"
� ��"�	 �('=�# �=		��.

2

min
VR

127(e f )
=

+

V (km/h) 
�C��[ 46�
ovjvfv�vevkvlvvllvlnvlmv

f
�
._B� @��]v/njv/nvv/lfv/lov/lmv/lnv/llv/lvv/lvv/vk

 �!%CYM8�4�	C Z	PX5� [��\ S



�}

 * �y�	�'# �
A" �	�% 	��) �� �A�Enter�# 9
� �'^  �	�% 		��.
 *����� ���^ �� �	

 �'^ W��)�:
)jgn(

)jgm(

)jgo(

)jgj(

)jgf(
 *9���	 W��)� 7�� �	)Z."jgl:(
T =�
5# >'[
E =�(�
� >'[

M =��
3# >'[
C  =�=) >'[(Chord)

S =�'^ >'[
 =��)���
5# )	 73� �

 * Z." �	jgl��" �	�	 �
/� 
���#��
0 7�� ���.
 *����	 �'^ L� �% ��3O='H% >
:=� W
) �'^ ���� >
w# L� �3O='H% �'^ 45�^ �	4
� ��#�  4
� �	

 ��.

T R tan
2
∆

=

1E R( 1)
cos

2

= −
∆

M R(1 cos )
2
∆

= −

C 2R sin
2
∆

=

RS
180
∆π

=

∆

 .P=YM8A"	
 ��� ���C� S



��

S (�3O='H% �'^:
  * �'�
	Line/Curves> Create Spirals> Spiral Type��Y!0 �	 ) �	�% ��(� �� ��" ��
| � )Z."jgn (  Clothoid �� 

L3= �� ��Y!0 ) �	�% ��	Ok�3!% .

 * �'�
	Line/Curves> Speed Tables> Create Curves�3!% ��(� ��  .�# ��
| �
#�� W� �	 ��� �
u30	'":
Select line (or POints):

�3!% S
;��� �� >)� �
5#  .�# ��
| �
u30 �
5� ��
�)		'":
Select line (or POints):

 �3!% S
;��� �� �)	 �
5# >
C) �	 �% 4
� ��IOsnap Setting  �!����Nearest       �
858# �8�8C��8� 
= �"
� >
A�  
8�
��'" S
;���.(

 *��Y!0 �)	 �
5# S
;��� �� {0 �Horizontal Speed Table�# �
�	'")Z."jgm.(

  *�!��� ��Y!0 7�� �I
� �	 �Select��Y!0 �	 ) �	�% L3H% �� � Select Speed Table 73���#
�   S
8;8��� �� �C��[ �
�3!%) Z."jgo.(

  *��Y!0 7�� �	 �aashto-m06.sup73�� �� �	
��
� �
!A# ���#
� ��)�	 �w%��C 
� '�"� �f %�#�"
�   .  �8� �('= 
� 7����
!�
73��  �P)�0 �w%��C ��)�	�#
� ) �	�% S
;��� �� �y�	�'# �Ok�3!% .

 .P=YM;�����
� ]�� S)_���	�(

 .P=YMUK/�
 �!%C S



��

   *�=�'B�	    �P)�0 ��)�	 �%�   %   73�� �� �.�  	'��#
�      ?w# ��)�	 
� �� 
�f   %�3!% S
;���   . �	�% $����) �� ��)�	 ��A� ZC��# �	
 )� %�# 	��) �� �"
� �y� 	�'# �% ��<�	 ���R# �� 
�93!%.
 *73�� ��Y!0 7�� �	 4
� �%V �� ��I�#
�����	 	'() 9� �	
�
% ) ��,
# �
�.
 * �� �A�Ok��Y!0 �	�%  �Select Speed Table��Y!0 ��   �Horizontal Speed Table�#��9�	��   .
 * 45�^ �	 >
CDesign Speed ?w#  �3!% S
;��� �� �'^ �C��[ 46�
km/h fv.
 *�!��� �Edit��Y!0 
= �	�% S
;��� �� 	'" �
� ��� �.

 *�# �
Y�� ��
	 K
&

N#  �3O='H% �'^ �
���#��
0 �	�% 	��) ���� �HC�# 7�� �	93�	.
 *����	 �'^ �
A"�# S
�C ��� >'#�� �� W
) ��	'":

)jg�(

 *�_��� )	 ���R# 7������� �� �� ��3O='H% >
:=� >'[�3!% S
;��� ��� �:

)jge(

2

cmin
VR

127(e f )
=

+

s1
3

s
s2

c

l 13.65Ve
l Max 0.036Vl

R

= 
 =  = 
 

 .P=YM<K/�
 �!%C T	?��� S

 .P=YMYK/�
 �!%C 7����! S



��

 *9���	 W��)� 7�� �	:
V =46

 �� ��#'H3% @�C�� �C��[ 46�

Rc =����	 �'^ �
A"��# @�C �� W
) ��

e =��!H���� 
� ��)�	
ls =��# @�C �� ��3O='H% >
:=� >'[
f = >)�( �� �&�
( �
._B� @��]jgl

 *�� ��� >
w# �'[V=60km/h  e=0.06  f=0.169���	  �"
�:

  *��Y!0 �	 >
C46�
 >)�( $����) �) Z."jgj (���R#  Rc     4858�^ �	 �� Radius               4858�^ �	 �� ��)�	 ���8R8#  
Superelevation RateM3NB 	�6 K�'B �� ) ��)�	 �	 ?w#f % 	�6  f�# 	��) ��   9838!% (         ���8R8# )  ls               $8;8� �	 ��
2Lane Spiral Length)�	
( �����_� )	 � (�# 	��)93!%.

 *�(�	 	�6  ��Y!0 �I
� 45�^ �	�� �'^ ��# S
�C �
%	'� �'[	'".
  *M3]'= :�(�	��)�� �'^ � �'^ >'[ �� )��)� ��%�# �lv�# ��#�"
�)����� 	����
�
� (              �8� )�8�)� 
8.8��8#� �	 )

�'^lvv�'^ �� )��)� �!�� �	  K'� mv4
� ��# .�(�	 ��#��
0 
� �� �'^ �D�# �
/� 
� 4
� ����� �� ���R# ) �!�	:

)jgk(
 �_��� 7�� �	R ) ��# @�C�� D�# �(�	 @�C�� �"
�.

 ���R# ���Rc�_��� �	 �� �jgk9���	  93!% 7��<�
( :

      ��� W
'= ��" �&

N# 	�6 ��� >
C    Z." �	 �����jgj   45�^ �	 Degree of Curve    �8(�	 K�'8B �� �� )    �
8/6� 
8� (
9���	 93
'!�:

   �# ���
/# �% �'_�
5�    ��� W
'= ��" �&

N# 	�6 	'" �����lv�# ��
	 ���R# ����� �"
�   .    �8% 4
� �� �#� 7�� Z3,	
              73�� �'* ) 9�	�% Z��&= ��# �� K'� �� �� >'[ �C�)  �P)�0 4�

 45�^ �	 �
% ������ �	  �8#
8�               '8�8"� �8C��8[ �

�#  �(�	 ) �"
�    ��)�� 
.��#� �	 �'^ �       �'^ >'[ �� )��)� ��%�# �lvv            �8� 	�6 7��  >'[ �C�) �33u= 
�  4
� K'� 
lvv     ��� ) ���
� �33u= ��#  �(�	 �����   ��)�� �� �'^ � �'^ �� )��)� ��%�# �lvv�# �&

N# ��# �!%   .     �8�
8% 7���
!�

     ��� W
'= ��" �&

N# 	�6 4
�      �(�	 �� Z��&= �� �A� �� ����� ) �
/6� 
� (   ��  lv         �8(�	 
8= 983!% 93�R=       �	 �'8^ �

2

cmin

c

60R 128.85m
127(0.06 0.16)

R 300m

= =
+

=

s1

3
s s

s2

l (13.65)(60)(0.06) 49.14m
l Max l 49.14m0.036(60)l 25.92m

300

= = 
 = ⇒ = 

= =  

10 2 R 572.96D
D 360 R

π
= ⇒ =

572.96D 1.91
300

= = o

19 05'055" 19 05'055" 19.1∧ ≡ =o o



��

��� 4
�� ����� 	����
�
�.
  *��Y!0 E'� ZC��# �
Y�� �� �A� Z." �jgj {�
 ) jgm �� Ok�� ) �3!% ��Y!0 �	 �
�          \'8_8� 	��8A8= S
8;��� �
)Z."jgf (�3!% L3H% �� �_�)	 4,
C  ��" ��
| �%.

 *�# 9
� �3O='H% �'^	'".
   *        ��8� K
&

N# 
� {�
 ) �	�% �&

N# ��
	 -)� 
� �� �3O='H% �'^ �
���#��
0 ����� �HC�# 7�� �	                 �8��
8R8# ���8��

�#93!% .��#� ��� �	 
���#��
0 7�� W��)�:
)jglv(

)jgll(

)jgln(

)jglm(

)jglo(

)jglj(

)jglf(

)jgl�(

)jgle(

)jglk(
 *W��)� 7�� �	:
Rc =����	 �'^ �
A"��# @�C�� W
) ��
D =�(�	 ��(�	 @�C�� �'^

s
s

l D
2 0

θ =

2 2 4 7 6 12 8 17s
s s s s s

l
x (100 0.3 (10) 0.43 (10) 0.3 (10) 0.14 (10) )

100
− − − −= − θ + θ − θ + θ

3 4 5 9 7 15s
s s s s s

l
y (0.58 0.13 (10) 0.12 (10) 0.05 (10) )

100
− − −= θ − θ + θ − θ

s c c sP y R R cos= − + θ

s c sk x R sin= − θ

c
1E (R P)( 1) P

cos
2

= + − +
∆

s c s cT x R sin (R E)sin
2
∆

= − θ + +

s

s

y
ST

sin
=

θ

s
s

s

y
LT x

tan
= −

θ

s cA l R=

 .P=YM`A"	C ��X2 "�%O� T	?��� S



��

ls =��# @�C�� ��3O='H% >
:=� >'[
 =��)���(�	 @�C�� �3O='H% �

xs =�3O='H% �)�" �� 4&�� �3O='H% �
+��� >'[
ys =�3O='H% �)�" �� 4&�� �3O='H% �
+��� �A�
P =�HB
�����	 �� �
5# 
= �
5# �)4�/�(
k =�HB
��3O='H% �)�" 
= ����	 �%�# �
E =�3O='H% �(�
� >'[
T =�3O='H% �
5# >'[

 =��)���
5# )	 73� �
ST =L*'% �
5#
LT =���� �
5#
A =�3O='H% ��#��
0
 *��" �	�	 �
/� 
���#��
0 7�� ��� Z." �	���.

  *�=�'B�	 W��)� �	 �� �H&^ ZC��# �	 ��" �&

N# 	��6� �%jglv 
= jglk4"�	 93��'�  93�	 ���^ .

∆

sθ

c

s

s

s

s

R 300m
l 49.14m

D 1.91
4.69

x 49.108
y 1.337

=

=

=

θ =
=

=

o

o

P 0.331
k 24.656
E 66.637
T 234.859
ST (S hort T angent ) 16 .35
LT (Long T angent ) 32 .81
A 121.42

=
=
=
=

=
=

=

 .P=YMa%�&��'  ��� ���C� S
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 * �'�
	Inquiry> Line/Curve/Spiral�3!% ��(� ��.
 *�# ��
| ��� �'�
	 �
#�� W� �		'":

Select entity (or POints)

 *�3!% L3H% ��3O='H% >
:=� �)� .����	 �'^ 
� 
�
�� �)� �% �3!% 4^	�3!.� L3H% W
) ��.
  * �'�
	View> Display> Text Window�3!% ��(� ��   .��Y!0 �	        ��8" �	�)� �838O='H% �'^ K
6?[� ��" ��
| �

4
� .�# �� K
6?[� 7���!�# Z�
� L� �)� �� ��'=(Text Document)4��� 4!��0 ) �	�% ��%.

   *   �# ���	 �% �'_�
5�   ��� K
&

N# 
� ��
	 ��	
R# 	'"	��	 ���';5� �����   . �3!% 4^	Theta   �
858� �#�"
�         .

   *    ����	 �'^ �)��� ��� >
C�3!% L3H% W
) ��   .��Y!0 �	 �Text Window   ��8��	 �'^ K
6?[�             �8�
8| W8
) ��
�#	'" .����	 �'^ ���� -)� 7�� ���# �3� �#� Z&^ 45�^ �	 �% �	

 ���3!% �	
��
� �3��'=.

   *��)�� ) �=)  �
A"  �'^ >'[����	 �'^ ��%�# ��&

N# Z�
^ ��� W��)� �� �����   .7�� �	 �3!% 4^	  �'8^ ~?��� 
(
  �	

Delta )��)������	 �'^ ��%�# �W
) ��   (  
�)��)���
5# )	 73� � (9���	 ) 4�3� �)
�#:

 *�# ���
/# �% �'_�
5�7�� �	 	'"��� ) ��
	 K
&

N# �3� 
(����	 ���';5� ������.

SPIRAL DATA: Clothoid
--------------------------------------------------------------------------------

TS . . . .  North: 5292.752             East: -10281.870
SPI. . . .  North: 5320.891             East: -10265.072
SC . . . .  North: 5334.231             East: -10255.548

               K : 24.565                 P : 0.335
               A : 121.417              Tau : 0.082
               Xs: 49.107                 Ys: 1.341

        Long Tan : 32.772             Course: 30-50-05
        Short Tan: 16.390             Course: 35-31-38

Length: 49.140             Radius: 300.000           Theta: 4-41-33

sθ

sTheta 4 41'36" 4.69= θ = =o o

ARC DATA
--------------------------------------------------------------------------------

Begin . . . . .  North: 5334.231             East:  -10255.548
Radial Point. .  North: 5159.904             East:  -10011.396
End . . . . . .  North: 5458.182             East:  -9979.298
PI  . . . . . .  North: 5476.944             East:  -10153.649

   Tangent: 175.358           Chord: 302.784          Course: 65-50-05
Arc Length: 317.379          Radius: 300.000           Delta: 60-36-54

∆

sDelta 2

Delta 70 2(4.69) 60.62
Delta 60 36 '54" 60.615

= ∆ − θ

= − =

= =

o

o o

c
DeltaT(Tangent) R tan

2
60.62T 300 175.376

2

=

= =

c
DeltaC(Chord) 2R sin

2
60.62C 2(300)sin 302.807

2

=

= =

c(Delta )(R )
S Arc Lenght

180
(60.62)(300)S 317.406

180

π
= =

π
= =
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`M��� �� ��@� ���O������
  *�'�
	Alignments> Define From Objects                  �838!8% L838H8% �3�# �)�  �3�# ������ �.�	�� �	 ) �	�% ��(� ��
) �	 �% 4
� ��IOsnap Setting  �!����Nearest	'" S
;��� ��C��� �3�# 
= �"
� >
A�.(

 *�# ��
| ����] 4#?6 �3�# ������ �		'".
   *         �"
� �3�# ������ �	 ��
� ����] 4#?6 �% �3!% 4^	   .�=�'B�	    ��
3# �	 4#?6 7�� �%         �'8�8
	  �8" ��
| �3�# �

�3!% L3H% �3�# �)� �3�# ������ �.�	�� �	 �3!% �A
 ) �	�% ��(� >)� �� �� �3�# s��A=.
 * >
C@3=�= ���.= �3!% S
;��� �� �3�# �<�	 �
� .W� ��" S
;��� $;�  45�^ �� S
;��� 
��# 73*	'".
  *�'^ �% �3!% 4^	�!��� ��Y# 45�^ �
 Z#
" �3O='H% �
�)��3O='H% >
:=�g����	 �'^��g   ��838O8='H% >
:=� . (

S
;��� ��" �)� 4,
C �	 �3!% �A
 ��
% 4^	 �������3� 9H^ �� �/;� �3� 
= �3�	 �
Y�� �� 
�.
 * �3�# Z% S
;��� �� �A�Enter�3�	 �
/� �� .
 *�# ��
| ��� �'�
	 �
#�� W� �		'":

Select reference point (Enter for start):

 * �<�	 �
� L�Enter�3�	 �
/� �� .
 *��Y!0Z." x�
_# ��fgl�# �
� 	'".

   *��Y!0 �	 �
� 
� ��" ��
| �Define Alignment  �83�# �)�" P���#'H3% ) �	�% 	��) ��';,	 �� �� �3�# s3B'= ) �
�  
$30 K�':� �%  t��0.000�3��� �33u= �� 4
� . �� ��Y!0Ok�3!%.

 *�# ��
| �
#�� W� �	 �3�# �
+��� ) ����� P���#'H3%	'" .
aMA�	,  )
���@� �
  *�'�
	Alignments> Create Offset ��Y!0 �	 ) �	�% ��(� �� ��" ��
| � )Z."�gl (  Outer offsetL3= �� �	�% ��	

     $;� �	 {�
 )offset�3!% 	��) �� �3�# t�6 s:� ���R#  �� 4
�� ) r*    . �3�# Z% t�6 ��� ?w#ll    48
� ��# 
     	�6 45�^ �� �	j/j   �3!% 	��) ��    . 45�^ >
CInner offsetL3= ��       Z8% t�86 s:�  4
�� ) r* ���� ) �	�% ��	

�3!% 	��) �� 4,
�
� . 4,
�
� Z% t�6 ��� ?w#�/n 	�6 $;� �� ���� 4
� ��# m/f�3!% 	��) �� .

.P=`M8���� ��@� V��O� S
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bMA	J�@����@� ���c�
   *    �'88�8
	Alignments> Station Label Setting              ��8Y88!80 �	 ) �	�88% ��88(� ��       ��8" �88�
8| � ) Z8.88"egl (           

Perpendicular labelsL3= ��  45�^ �	 ) �	�% ��	Station label increment   )Station tick increment   �8H8B
8� �
@�*���
<���� ����3!% 	��) �� 
� . 4"	 �	 I'5A#jv �� ��#jv �
���'% �	  ��#nv �� ��#nv�'^ �	 ) ��# 
�lv ��#

 ��lv��# . 	�6 �	�% 	��)lv �!A�  lv �� ��# lv�
<���� ��# 	'" ���F�.
 * �'�
	Alignments> Create Station Labels  �
� �
 ) �	�% ��(� �� Enter�3!% .
   * @�*�� �3�#�# ���F�	'"   .                         ����8�� �8��'8;8� �8��
8% �8�� �8% 48
� �8%V �8� ��I                                   �'8!8# �	 �� 78�8# �

Format> Text Style7�� ����  �!% t'6 @8�*�� �)� �33u= 7�� �%     �
8<8�8���                       �'8�8
	 �8�
8� 	'8" >
8586� 
8�
Alignments> Create Station Labels �!% ��(� ��
�)	 �� .

9M)H� ��,� %,d ���O�
  *Alignments> Set Current Alignment   :�# �� �P)�0 
� �#
��� �% �
� ���# ��
�)	 ) ���!�     �8�'8" �P)�0 	��) �3��'�

 �� {0 ) �3!% ��(� �� �'�
	 7�� ��
�Enter�N�B �	 �	�%  ) �	�% S
;��� �� 	'� �3�# ��" �
� �OK�3!% .
 *Terrain> Set Current Surface  :��Y!0 �	 �'�
	 ���(� �� {0 4
� ��I �P)�0 �� ���( 	)�) �� �	 M_
 ��" �
� �

 ) S
;��� �� ��" ���

OK�3!% .
*Alignments> Alignment commands> Multiple Selections  :��� �� �3�# �!* 
� L� �	�% �
0 ���������

   *View> Regen All   :�3,)� 4,
C �� >
."� ����	���� ����	'� �   .�=�'B�	�'^ �%  �8!�"�	 ���." 4,
C �3�# �
�
��	���� >)� 4,
C �� 
= �3!% �	
��
� �'�
	 7�� ��.

.P=aM8A�	,  V��O� S ��@� �
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8:M�1�$ .��!�� ! Q��� 3	/	B��� )
�
  * �'�
	Projects> Menu Palettes�N�B �	 ) �	�% ��(� �� ��" �
� �Civil Design        �8!8��8� ) �	�% S
;��� ��  �

Load�3!% L3H% �� .
   *   �'88�88
	Profiles> Profile Setting> Sampling��         ��88Y88!880 �	 ) �	�88% ��88(�                               488588�^ �	 ��88" �
88� �

Sample offset tolerance 	�6v/j�3!% 	��) ��  . $;� �	Sample lines  �!����Import              
8= �838!8% L83= �)�� ��
��I ��I �'!# 	��) 45�^ 7�� 	
�� �
�	'/� 
� . 45�^Sample left/rightL3= �� ���� ) �	�% ��	offset  4
�� ) r* 

�3!% 	��) �� ��� Z% t�6 s:� ���% �� ����)Z."lvgl .( �� ��Y!0Ok�3!% .
  * �'�
	Profiles> Profile Setting> Labels and Prefix             4858�^ �	 ) �	�8% ��(� �� Layer Prefix                 L8� ��8�8��
*) ��
�
 (�3!% 	��) �� ��';,	 �
� {�
 ) �	�% 	��)) ?w#*Profile(
  *�'�
	Profiles> Existing Ground> Sample From Surface ��Y!0 ) �	�% ��(� ��  �� ��" ��
| �Ok     �838!8%    . �	

�# ��
| �3�# �
+��� {�
 ) ����� �
<���� $
�0 �
#�� W�	'" . �� )	 ��Enter�3!%.
 * �
u30 ���Vertical alignment already exists, retain finish surfaces?�!��� �)�  �" ��
|  �Yes�3!% L3H%.
 *��'5� �� �!&# �#
u30 �
#�� W� �	�# ��
| �3�# �� ���	��	'".
  * �'�
	Profiles> Create Profile> Full Profile�	�% ��(� ��    . $;� �	Profile Creation Parameters     �8!8��8�    �

Left to RightL3= �� �	�% ��	)4
�� �� r* �� Z3�)�0 9
� ���� ( )Import Left/Right Profile    �838!8% L3= �)�� �� 
 )  L3= K�'B �	    ��� �!��� 7�� �	�% ��	                 �8# 98
� �� ��� 4
�� ) r*  W
) W� Z3�)�0 �
 �����  �8!8%   . (   �8!8��8�      �

Import Grid  L3= ��    �HB
� ) �	�% ��	       �83!% 	��)  7���� 4!��0 ���� 	'� �y� @�C�� �� 
����� �
�=�� ) 9`
^  �R�� � .
���# 
5!��� ��'!6 @3=�= �3��'=nv   j ) l�3!% 	��) �� )Z."lvgn .( �� ��Y!0  	��6� �	�% 	��) �� �A�Ok�3!% .

.P=bM8[@d�� S ��@� ���
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 *�# ��
| ��� �
u30 �
#�� W� �		'":
Select starting point:

   *�_R�    �	�% S
;��� �'# L3H% �
� L� 
� �N�B �)� �� Z3�)�0 �)�" � )  �83!% S
;��� ��
( �	 �� �_R� 7�� �3!% 4^	
        �"
&�  ��" 9
� �N�B �	 ?&^ ���� �)� �%   (            Z838�)�80 �	�8% �
0 >�'
 �� �

0 �	 �
#�� W� �	 )                   �8H8&8^ �
8�

No     ) �	�% r�
= �� Enter�3!% ) �
#�� 
� �3"
� �	�% 9
� �,'[ Z3�)�0 ?&^ ���Yes �
( �� No�# �� �3��'=    �
80 �� 
�3!%.(

 *��� W
'= �A3&[ 73#� 43A])�# 9
� �����	'".
   *��.�   :            �!N!# K
6
�=�� 
� \
R� �	 ��33u= 73#� t��'6 Z3�)�0 9
� �� �A� ���         �8�8.�  x�
_# ) �" �
Y�� ���3# �
� �

�N�B  �ln �
� 4
� ��I  �3��

 ��
�)	 �� M_
 ) 	��) �� K��33u= 7�� lv)     �8,'8[ Z83�)�0 ) 73#� K
6
�=�� 9
�   ( ��
�3!% ���.= ��
�)	 ���( M_
 ����.

   *  ��
5" �.3=�'B �	 �
<���� �  �#  4
� ���� 9� �	 
���
5" �� �.� �3��'= �'�
	 
� �� 
�Rotate     
8� {8�
 ) ���
��* 
 �'�
	Match Properties�5���
5" ��3�
���� �� 
�.

 *�# �P)�0 W� 9
� �� 4�'�  73#� t��'6 Z3�)�0 9
� �� �A��
�.

.P=8:M8A�+,� 3	-�e,�S���-� � ��@� �� ���"��

.P=8:M; .��!�� K2	
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 *	��	 	'() -)� )	 �P)�0 W� 9
� ���� �HC�# 7�� �	 .lg ��
	 -)�ng�
<���� P���#'H3% -)�
�
 *-)� 7�� M3]'= �� Z&^���3<� �y� �	 �� ��� K
.� �P)�0 W� ��3/% �	 4
� ��I 
�:
lg@3"�!.� �)
Y= �
Y# 	)�C �� �P)�0 W� �
�.
ng73#� �		'" 4�
6� �,'[ @3" Z^��C M_�# �
�.
mg	�F<� �P)�0 ��
&(� \
R� �� �P)�0 W�.
og�'^ �3!% �A
 ��+� ��	 	
Y�� �����	)�N# �	 9`
^ 	'" x&_!# �� �� ) ����� ���^ �R�� �'^ � .
jg�'^�'^ �)� 9`
^ �
����3<� ���^ �3O='H% �
�)�'^ �,)�# 9`
^ �
��	

 �'^ �)� �!��'=����	 ����3� ���^ ��.(
fg�'^ �)�" 7�������^ ���3!% �3��0 9`
^ �'^ �	 �3= �R�� �
�.
�g�"
� ���^�� >	
A= �	)�C 
= ����%
� ) ���	�&%
� 73�.

.P=8:MU��� %� ! T�2 �#��$ S ���� ! )*	� �	(

�'^ S'� E
&_��   �
�
�R�� ) 9`
^)S'� �C��[(

 Z3,	 �� ��!��� ��	 $�
%
�H^ ��3����^ �	 9`
^ �'^ �

�R�� �'^ �)�")�� �C��[(

�'^ 73� �<!�
5�
� �
�
 �R�� �'^ )  �R�� ) 9`
^

4/09�)�� �C��[(

�R�� �'^ �)�� 9`
^ �'^)�� �C��[( �R�� �'^ �)�� 9`
^ �'^)�� �C��[(

9`
^ �'^ �)�� �R�� �'^)S'� �C��[(
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  *�'�
	Profiles> FG Centerline Tangents> Create Tangents �3!% ��(� ��    .�
u30 �
#�� W� �	      �8�
8| �8�� �
�
�#	'" .���.� �� 
� �.�Enter�3!%.

Select point (or Station):

Station <0.000>: 
 
Elevation <2170.000>:

 *�# 4���� �'# 
� �% �_��# Z:�# 73#� t��'6 Z3�)�0 ������ �� 	'"	'" .
 *�# ��
| ��� �
u30 �
#�� W� �		'":

Select point [Station/eXit/Undo/Length]:

lg��
	 -)�   :
  * �
u30Select point [Station/eXit/Undo/Length]:�_R� �% ��          �8# @8H8[ �� �P)�0 W� ��A� �    �8!8%

�# �

0 �N�B �	 �_R� S
;��� 
� 
53R��#93�	 .�'N�4
� ��" 7�� �� �
% �:
     �# ���	 �N�B �	 �% �_�                   
8� �% 4
� �P)�0 W� �
5�  4
� Z:�# 73#� t��'6 Z3�)�0 ������ �� �� ������ ) 	'"

 �# 4�
� Z3�)�0 �)� �_R��� �	 �'# L3H%	'"  .�
<���� �)� �'# L3H% 
� 	'� �3��'� �	
^ 7����
!�      �8y8�	�'8# �
�
    �3!% 9
� �� �P)�0 W�   .         �
<���� P���#'H3% ����� �
% 7�� �� Z&^ 4
� ��I �,)      �'^ �
+��� ) ��
3# ) ����� �
�    �8R8�� �
�

                    �
<���� 7�� P���#'H3% �� �('= 
� {�
 ) �	�% 4"�		
� �?0 �)� �� �� �P)�0 ��
&(� \
R� ) �3O='H% 
� �	

        	��'8# ) 
�
m 
= ��3!% 9
� �� �P)�0 W�    . 	��'#l)n �
� �	 �� le�# $����) ) >��!% 93!%   .     �
858� 
� �P)�0 W� �<��." \
R�

    �'^ ZN# @3" �33u= \
R�     �
� �	 �% �!��� 9`
^ �
�ll�# �C��[ ��'"   .       �� �P)�80 W8� 9
� �% 4
� �%V �� ��I
 45�^ 7���5+# �P)�0 �
�        	��	 J
3�C� �	
�� 4^	 �� ) 4
� ��
���� �   .                      �	'8� 78")� �8�8
	 98
� �	 75]�	

Nearest ) Endpoint�# �
3� K�'B �	 �"
� �3�# ���'= . ���3
� Z3�)�0 �
�
0 �� ��^)Enter�3!%.
ng�
<���� P���#'H3% -)�
� :�� �� �A� �
u30 �%Select point [Station/eXit/Undo/Length]: �
#�� W� �	 

 ~�C  �" ��
|S ) �	�% r�
= �
#�� W� �	 �� Enter�3!%  .�# ��
| ��� �
u30	'":
Enter station: 1495

�3!% 	��) �� �y�	�'# �
<���� P���#'H3% .�# 	��) ��A� �
u30	'":
Select point [Grade/Elevation/Undo/eXit]: 

   ~�C ���G    ) �	�% 	��) �� Enter��� �3!%          �8# @8H8[ �
8<8���� 7�� ) >)� �
<���� 73� �� �P)�0 W� @3" �����  �8!8%    :
Grade (%):   . ) r�
= �B�	 
� �� @3" 	�6Enter�3!%    .        @838" �8�� ?w#j   %              �838!8% 	��) �8���	 ��8����8
 �	             :

Grade (%): -5 .����# 9
� �� �P)�0 W� �� �.= 7�� ������!%.
�
u30 ��
�)	Select point [Station/eXit/Undo/Length]:�# ��
| 	'" .�3!% Z56 Z&^ �!�
#.

�=�'B�	 S�'( �	 �%Select point [Grade/Elevation/Undo/eXit]:��  �
(G    ~�8CE                �838!8% 	��) �� 
����_R� �
�=�� ������# �% �� ���# @H[ 	'" ZB) �� �� �
<���� 7�� �	 �P)�0 W� �3��'��!%.

 �
u30 S�'( �	 ��� 75] �	Select point [Station/eXit/Undo/Length]: ~�C L      ��8� �838!8% 	��) ��         ���8��
���# �% �� �R�� >'[  P���#'H3% �
(�_R� �� 
= ��)� 'H( �3��'��# @H[ �3
�� �P)�0 W� ��A� ��!%.
 *�# �	
��
� �P)�0 W� 9
� ���� �% �")� �� �� �3!% 4^	 �3!% �A
  �3!%���
��	 ��" �%V 	�'#  �P)�0 W� 9
� �

�� 
= �����3<� �y��	 93
�= �	 4
� 7.5# �% 
( . �
� �	le	�% 93��'� $����) �)�, K�'B�	 �� �P)�0 W� .
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  *�'�
	Profiles> Label> Tangents  �83!% L3H% �P)�0 W� 45�^ �� �)� ) �	�% ��(� ��    .           ) �P)�80 W8� @838"
   �# ��"'� �� K
6
�=��	'"   . 7�� ����                  L8� 783#� t��'6 Z3�)�0 �� �����  �!��3� 9� �)� �P)�0 W� ) 73#� K
6
�=�� �%
 �"'� �	 ) ����� ��%�3�	 ���^ �N�B �� ��<�	 �)4!��0 ����  .(         
8= �838!8% �
0 �� �HB� Z3�)�0 �)� t��'6 {�


�� �
( �P)�0 W� t��'6�!3/!� 
� .����	 �� �P)�0 W� K
6
�=�� ) �,'[ @3" 
5" �HC�# 7�� �	.
88M��� �#��$)*	� �	(
 *�'^ �C��[�'^ 4,
C )	 ���� �� 9`
^ �
��# �
Y�� �
% ) P'% �
�93�	.

s,� (�'^P'% �
�)W� �	  S�N#  ���,�Crest(
 *�'^ 7�� �C��[��
0 �� 
��# �
Y�� 4R&
 ��	 4�
�# ) s^'= ��	 4�
�# Z^��C �	�3�.
 *s^'= ��	 4�
�#)Stopping Sight Distance :(��� 4�
�# )	 �'5Y# Z#
" �_� �)�� s^'= 4�
�# Z^��C:
lg  �H3
) �% ���
�#         �# ���
/# �� T�
# ��!��� �% ��
#� �� �3HR� �  {.6 ) �!%  �# �
/� Z5A,�    �8# �[  ��	     ) �8!8%

�# �#�= 4�
�# 7�� �[ �� �A� �HB
�?��!%.
ng�yN, �� �% ���
�#�# �[ Z#
% s^'= 
= �#�= ��!%.

�# �&

N# ��� W��)� �� s^'= ��	 4�
�# Z^��C	'":

)llgl (
�"
� @3" �)�� �	
( M_
 �% ��,
C ����.

)llgn (
4
� ��I
��
 4,
C�	 .

)llgm (
4
� ������
 4,
C�	.

 *9���	 W��)� 7�� �	:
S =s^'= ��	 4�
�# Z^��C)��#(
V =�H3
) 46�
�3HR� �)46

 �� ��#'H3%(
t ={.6 �
#�Z5A,�) '�"� 	
+!/30 x&[ ��n/j�3�
� (
f   =   �H3
) L3�
I �
._B� @��]   �8�8����y��	 {3� ��

)� 4,
C �	 �C��[ ���� �% �	
( ��

)� �)� �� �3HR� �

�#���'"�!% S
�" �

��� 
�)  	'"�# 733A= 73"
# �	'").>)�(llgl)llgn ( 
G =�	
( �,'[ @3")G�# ��"'� ��B 
� >'#�� �	 	'" . ��� ?w#G=2% 	�6 >'#�� �	  �"
�v/vn�# ���^ �� 93�	(

2 21 V VS SSD Vt 0.278Vt
3.6 254.2752 f 254f

= = + ≅ +
×

2 21 V VS SSD Vt 0.278Vt
3.6 254.2752(f G) 254(f G)

= = + ≅ +
+ +

2 21 V VS SSD Vt 0.278Vt
3.6 254.2752(f G) 254(f G)

= = + ≅ +
− −
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*AASHTO, “Policy On Geometric Design of  Streets and Highways,” Washington, DC, 1990 and 1994. 
** >'#�� ��llgl 7�����y��	 
� t=2.5s

 * '�"�nvvl���'"�!% 4�
� S
�" 7�����y��	 
� �� �
._B� @��]  �a=3.4m/s2�# 4
��	�)�:

)llgo(
9���	 s^'= ��	 4�
�# Z^��C ���� ):

)llgj(

 * >)�( �	llgn4
� ��#� ��	
R# 7�� .

f
 �
._B� @��]
 ��

)� 4,
C �	

{3�*

V(km/h) 
�C��[ 46�


v/ovmv
v/meov
v/mjjv
v/mmfv
v/ml�v
v/mvev
v/mvkv
v/nklvv
v/nellv
v/nelnv

S(m) 
�HB
� Z^��C �

 �!3+� s^'= ��	
�C��[ ����**

nk/f
oo/o
fn/e
eo/f

llv/e
lmk/o
lfe/�
nvj

nof/o
nej/f

 �!%C88M8V��� %�" K�	@� .��%# ! Z	PX5� [��\ S

2VS SSD 0.278Vt
a254( G)

9.81

= = +
±

2

2

a(m / s )f
9.81(m / s

=
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* >'#�� ��llgj 7�����y��	 
� t=2.5s  a=3.4m/s2  G=0 
**AASHTO, “Policy On Geometric Design of  Streets and Highways,” Washington, DC, 2001.

 *�'^ �C��[ �		��	 	'() 4,
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4�3�   .   ��	
R#Headlight height(HH) )Headlight angle���" �	�	 M3]'= �
% �'^ 45�^ �	.
 * �'�
	Profiles> FG Vertical Curves�3!% ��(� ��  .��Y!0Z." x�
_# ��llg��# �
� 	'".
 *-)� ��Y!0 7�� �	�'^ �C��[ sH�;# �
�4
� ��" �`��� �
% ) P'% �
�.
 *7�� P'% �'^ �C��[ �����# Z56 ��'�93!%:
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� llgo���)� 4
	 �� .
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� �S ) L4
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oglg>)� 4,
C :L>S �"
� .�3!% Z56 ��� @3=�= ��.
 *�!��� �)� �Length �� ��Y!0 ) �	�% L3H% Ok�3!% .
 *�# ��
| ��� �
u30 �
#�� W� �		'":

Select incoming tangent:

 .P=88M`�#��$ �	(�����	� )�e,� S) ��=>899<(

( )α



h�

 *�3!% L3H% P'% �'^ �	)�) �
5# �)�.
 *�# ��
| ��� �
u30 �
#�� W� �		'":

Select outgoing tangent:

 *�3!% L3H% P'% �'^ �()�� �
5# �)�.
 *���

 �� P'% �'^ �% �_� 
� �
5# )	 73�4
� �()�� �
5# ��
�� 45
 ) �	)�) �
5# ��* 45
  ���.
 *�# ��
| ��� �
u30 �
#�� W� �		'":

Length of curve: 
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� �� ��#� 4
	 �� �'^ >'[ 	�6n�3!% 	��) �� �� �� ��/3� �	�6 
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� �3� �� �P)�0 �	��   . �	�% 	��) �� �A�L  �
#�� W� �	Enter

�3!%.
Length of curve: 270
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� ��" �C��[ �'^	'" . �'�
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 * �3!% �C��[ -)� 735� �� �� ����	 �,'[ Z3�)�0 �	 �% P'% �'^ 	��A= ��.
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8;M��� �� G"� [@d��)*	� �	(
  *�'�
	Profiles> Labels> Vertical Curves @3" �)� ����� ) �	�% ��(� ��  )�
5#   (    ) �8()�� @3" {�
  �	)�)

 �3!% L3H% 9`
^ �'^ 	'� �)� 
+��� �	 .�# ��
| 9`
^ �'^ K
6?[�	'" .7�� �	 
(A.D. ���R# �
5�A  98`
^ �'^ �	 
9���	 ) 4
� :A=g2-g1 �%g2 ) �()�� @3" g14
� �	)�) @3" .g2)g1�# �
3� �B�	 @�C����'" . ��"�	 ��� ?w#

 93"
�g1=+2%)��I
��
 @3" �!A� 4&w# 4#?6( )g2=-5%)�!3�
0�
 @3" �!A� ��!# 4#?6(4"�	 93��'�  :
A=-5-2=-7 

8UM)*	� ��@� ���O�)AN!�� 62+���)*	� �	( (��� �������
  *�'�
	Profiles> FG Vertical Alignment> Define FG Centerline �	�% ��(� ��    .��I Z%   �8�I �Y� �N�B �
�  �

   �# -'#
� �P)�0 W���'"   .           �.= ) �	�% �)�" �P)�0 W� ������ �.�	�� �� @3=�= �� >
C     �� �P)�0 W� �
� @3=�= ��   �� 
    �3!% S
;��� 4
�� �� r*   .   �.=  L3H% �� 
�   W� ��" S
;��� � �# 73*	'"   .            Z8#
8" 
8+8!8= 9`
^ �3�# �% �3!% 4^	

�
5#  �'^ ) 
�       �
/� �� ~�[ )	 W� )	 ) �Hw# 4#?6 ) 4
� 9`
^ �
���!�	�#'
 �          �838�# )�8( ) �	'� �'^ �
�!��3� .�# ��
| �P)�0 W� �)�" �	 ����] 4#?6 L�  �3�# ������ �	 L3H% 73,)� 
� 75] �		'".

   *   �5� S
;��� �� �A� �.= �   
�Enter�3!%   . 	��A= �
#�� W� �	PVI�# �	�	 �
/�           	��8A8= �'858Y8# 	�6 7�� �% 	'"
�_R�4
� 9`
^ �'^ �� ��� ) 
+���  ����� �
�.

8<M���-��\�/ 
$	�� ���� Q��� �� ���"��
  *�'�
	Cross Sections> Existing Ground> Sample From Surface           ��8Y8!80 �	 ) �	�8% ��(� ��          ��8" �
8� �
 )Z."logl ( $;� �	Swath Widths��'5� t�6            �� 48
�� ) r* ���	��ov           �838!8% 	��) �8�8#    .               4858�^ �	

Sample Increments�HB
�  ��'5� ��HB
� �
5� 
� ) ���	���3!% 	��) �� �]�6 T[
R# �   .���          �8� �8�C 4
� �	
^ �����
�HB
�  �
�l�!% 	
Y�� �]�6 T[
R#  ���#  .	��	 �<��� ��!+# �y� ) �P)�0 K�'B �� S
;��� 7��   .��   T8[
8R# �H%�'[
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� ) �P)�0 ��
&(� \
R� �!�
# �B
� \
R� )  
�                 t'86 �8]�86 T8_8R# Z." �% ��
�
�#�# �	�  	'" t'6 ��� t�6 �A� �� P���#'H3% L� �� ��^) ?w#  	'"��'".

   ��� �3��';� �.3=�'B �	  �
<���� �	 �����                     �8#  �8!8%�838,'8= �8]�86 T8_8R8# �838� X
� �
�        �8!8��8� �838��'8=                           �
Add specific stationsL3= ���3!% ��	.

 * $;� �	Sample Lines�!���   �ImportL3= ��  �� ��Y!0 ) �	�% ��	Ok�3!% .
   *        �# ��
| �� �
+��� {�
 ) �3�# ������ �
u30 �
#�� W� �	 �� )	 7��  	'"Enter�3!%   .��
��	 �'
 �
u30    �8�
8]� �

 ��
5" �	�%�
<���� �4
� X
� 
� ����N� �
� . ���Add specific stationsL3= ��      �8�
8| �
8u30 7��  �3"
� �	�% ��	
�#	'"   .��
5" �
<���� �      �
� �� ) 	��) �� �y�	�'# �
�Enter�3!% )��
5"�
<���� ��# �� ��';,	 �
�       ���8(� 
8� �3��'=

 �'�
	Alignment> Station/Offset> Label�_R� �	 �3�# �)� �	�% L3H% ) ���)� 4
	 �� �y� 	�'# �.(
   * ���
/# K�'B �	 �
u30 �Overwrite�5H%  �
#�� W� �	  �Yes 
� Y {�
 ) r�
= �
#�� W� �	 �� Enter  �838!% .

�# ��
| ��
#� �
#�� 7����'5� Z56 �% 	'"�3"
� �	�	 �
Y�� �3�# ���� �3� ?&^ �� ���	��.
 *��'5� �
u30 �
#�� W� �	�# ��
| �3�# �� ���	��	'":

You have sampled sections for 2615.696 meters of alignment.
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 ���� �3� )  ��'"
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% ZC��#:
  * �'�
	Polyline�N�B �	 ) �	�% ��(� �� �3!% 9
� ��� Z% �t�6 s:� �>'[ �� �R�� W� L�  93
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          �_R�  �N�B �)� L3H% 
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8C �	 �� W� �'# 
� {�
 ) �	�% 733A= �� W� >)� �
 ) �	�% 	��) �
#�� W� �	 �� ��� t�6 s:� 	�6  ��"�	 �
<� �R��Enter�3!% .

 * �'�
	Cross Sections> Templates> Define Template�3!% ��(� �� .9���	 �
#�� W� �	:
Pick finish ground reference point:

 *�_R� �)��3!% L3H% 4
�� 45
 �	 W� ��
+��� �) 4
� ��+�Endpoint�"
� 7")� .(
 *�# ��
| '<,� �	'� ��
R�# �
u30	'":

Is template symmetrical [Yes/No] <Yes>:

 * �� �
u30Enter�3!% )�	'� ��
R�# -��F0.(
 *9���	 �
#�� W� �	:

Select template surfaces...
Select objects:

 * ) �	�% L3H% W� �)�Enter�3!% .
Select objects: 1 found

 .P=8<M8���-� 3	-�e,� S�\�/ 
$	�� ���� Q��� �� ���"��
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#�� W� �	:
Surface type [Normal/Subgrade] <Normal>:

 * �� �
u30Enter��Y!0 �	 ) �	�%  ��" �
� �Granular)���	�� ( �� ��Y!0 ) S
;��� ��Enter�3!% .
 *9���	 �
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Pick connection point out:

 *�_R� �)��3!% L3H% r* 45
 �	 W� ������� �.
 *��� �
u30)��
5"�_R� ���F�
� (�# ��
|	'" .�� �� Enter�3!% :

Datum number <1>:

 *9���	 �
#�� W� �	:
Pick datum points (left to right):
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